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All the Solutions in Review

Project Management

In PM solutions we support many project methodologies such as Agile 
and Simple Projects. Methodology solutions help in implementing best practices 
in project management. CS Odessa provides Toolbox solutions to support solving issues 
related to planning, tracking, milestones, events, resource usage, and other typical 
project management functions. Toolbox Solutions help you deal with common project 
situations in an extraordinary way.

PM Easy

This solution helps you quickly start a project by listing task relationships 
and dependencies to make iterative planning easy. Visual tools, such as mind mapping, 
increase the effectiveness of task tracking and analyses.   

PM Agile

All Agile meetings and documents are powered by mission adapted mind map .
templates, specially tuned for collaborative work. Tracking project Velocity is easy when 
using ConceptDraw Velocity diagram templates.

PM Response

This solution helps improve response time to project changes. PM Response .
also helps with iteration planning, discussing project layout approaches, and solving 
project challenges.

PM Teams

ConceptDraw Solution Park creates a single information space for messaging to teams. 
PM Teams provides project participants and organizations with better tools that assist.
in task understanding, timeframe understanding, and project events in the entire .
organization. Improved communication fosters positive team spirit throughout. 
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PM Docs
Organize project and company documentation and structure information that relates .
to project. PM Docs makes it easier to locate pertinent documentation over the life .
of the project; by improving document access and minimizing search time. The end result 
is improved productivity of the project team. 

PM Presentation
The presentation becomes a key component of your company’s organizational process 
when you can use available project information in your meetings that is tuned .
to audience requirements. By using the same data and building targeted .
presentations for your audience you compound your efficiency and clearly .
communicate the appropriate information to different audiences from a single source. 
The power behind this solution improves your efficiencies in many stages of the project 
management process.

PM Meeting
PM Meeting makes preparing for meetings a quick task. Meetings become more .
efficient because of the ability to easily record results. Collaborative decisions .
made by the project team are captured as part of the meeting process and then .
distributed. This innovative process makes meetings more productive and keeps .
activities on track. Meeting notes can be easily distributed at a meeting’s .
conclusion to all participants and stakeholders.

PM Planning
PM Planning automatically creates documents that reflect a project’s status for people 
who have different project roles. Individuals are able to use the reporting capability built 
into ConceptDraw Solution Park for their benefit. The report capability addresses more 
than management requirements and is a great tool to guide individual task .
completions.  This solution in ConceptDraw Solution Park improves planning for all team 
members and is a strong management and productivity tool. 

PM Dashboards
PM Dashboards clearly displays identified key performance indicators for any project. 
Dashboards demonstrate to project managers where corrective action needs to be taken.
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PM Personal Time Management
The PM Personal Time Management solution helps every project participant track .
timeframe, workspace and function in a project with the help of Microreports, .
calendars, and to-do lists.

Every project participant stays informed about task lists, calendars and future tasks .
for self and colleagues. The PM Personal Time Management solution is good .
for collaborative work, keeping everyone informed on what and when tasks need .
to be done. Time Management is critical for the success of any project. 
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How ConceptDraw Helps With Project Management

We create innovative value in project management using well-known methodologies. .
An important part of our business .
is to support and enhance project .
management methodologies. We extend 
them by providing extra tool box .
solutions. We create practical value .
for your project through our PM Solutions, 
available in ConceptDraw Solution Park.  
Our solutions increase the general .
effectiveness of your work by supporting 
the methodology you use .
in your specific project. 

Each project has its own individual .
challenges because of the project’s .
environment. Using a proven project 
management methodology, supported .
by PM Solutions from ConceptDraw Solution Park allows you to extend .
the effectiveness of that methodology. ConceptDraw Solution Park helps you quickly 
adapt to the uniqueness of any project situation. 

ConceptDraw Solution Park improves your project management activity .
by providing you with Toolbox and Methodology Solutions. Toolbox Solutions enhance 
your daily project management activities regardless of your project methodology. 
Methodology Solutions help with your specific project management practices.

Typical Tasks for Any Project Manager

There are a set of universal activities that every project manager faces. .
These activities are core to any project, and many of them are common, regardless.
of the project phase. Presentations are important to project management.
to keep everyone informed of project progress and changes that occur during.
a project’s life cycle. In addition to presentations; other critical and traditionally 
labor intensive activities include  project documentation generation, running effective 
meetings, and capturing meeting outcomes. Equally important are time management, 
planning and reporting, and tracking project results.

Many projects are driven by a specific project methodology that guides the project .
procedure during the development and execution of a project. In addition .
to the methodology practice there is often a requirement to manage change .
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from a tactical viewpoint, keeping the project on time and on budget. Project managers 
need tools to help them with these tactical requirements.

Because of the different situational requirements that can occur in a project, CS Odessa .
has provided two sections of ConceptDraw Solution Park that are built for the project 
manager. Our solutions provide support for general project issues and for project 
methodologies. The ConceptDraw Solution Park toolbox has many solutions .
that address issues faced  daily by project managers. The methodology section includes 
solutions that provide assistance for small project and Agile project approaches. .
In the future, additional methodologies .
will be supported.
in ConceptDraw Solution Park.

The toolbox section.
of ConceptDraw Solution Park.
addresses many daily .
tasks ofproject managers, such .
as creative planning, project changes, 
project environment, documentation, 
project presentation, effective meetings, 
personal time management, planning.
and reporting, dashboards, and tracking.

In practice, for many project tasks, the project methodology you use does not come into 
play. Situational problems always must be resolved. Because project environments.
are volatile and ever-changing, you need a simple to use and powerful tool to help .
you with problem solving.

Project managers  who  struggle with daily challenges should look at what is available.
for their use in the ConceptDraw Toolbox for Project Managers. To better support .
a specific project method, look at our methodology section that provides a range .
of solutions to  support your project efforts.

Methodology Solutions 

Project management is a branch of science that evolves quickly, and the pace is ever 
quickening. As a result, there are many methodologies that have developed unique 
characteristics so that they can better adapt to a project’s specifics. The meaning .
of the word “project”, as derived from Latin, means a unique event that does not repeat 
itself. Because of this attribute, no universal project methodology exists. .
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Every methodology has its loyal 
supporters that understand the inherent 
strengths of that project method.

Selection and implementation of any 
project methodology in a company has .
a huge impact on financial and time 
resources. Project methodology can also 
impact organizational structure. .
Consequently most companies adapt .
a standard project methodology for all 
projects. Seldom are changes made .
in this decision because the changing .
of methodology is a costly process. 

Innovative changes occur within the methodology. These innovations result .
in the potential to save time, increase project quality, and also equip organizations .
to better adapt to unique situations. These adaptations improve productivity. .
Often, new projects leverage the experience gained from preceding projects. .
The net effect is improved ability to compete in the organization’s marketplace.

Our methodology solutions do not require any changes to existing company project 
processes. Our solutions introduce innovation into organizations.  ConceptDraw project 
management solutions help organizations in many ways, and introducing innovation into 
the project management process is just one way companies can benefit from .
our product offerings. Innovation can increase your probability for success, and also save 
time and money resources. 

The methodology solutions provided in ConceptDraw Solution Park are professional 
project tools that support one or many steps of the methodology you use increasing your 
overall effectiveness. Increased overall effectiveness improves the value .
of your project methodology in your organization. 

Toolbox Solutions 

Whatever methodology project managers use, there are always day-to-day issues .
in project management. .
These issues relate to planning, tracking, milestones, events, resource usage, .
and many more variables that are found in a typical project. .
The project environment always has a major impact on identifying critical .
or noncritical inside the project. For example, in one project, the distribution .
of resource assignments could be critical, in another project, the critical issue could 



12

Solution Park Support for Project Management

involve team communication about .
the task completions status, 
accomplishing objectives, or just making 
a great project presentation. 

The project environment always .
creates new tasks which do not fit .
in the direction of the primary project 
objectives. These new tasks are often not 
addressed in the framework .
of the chosen management methodology 
and can have a large impact.
on project success. 

Following the management methodology 
may be required, however, the project environment can produce circumstances where 
addressing tasks can require project managers to use project tools that are not part.
of  of the management methodology. It is normal for these types of tasks to occur,.
and they must be addressed to complete the project. .
Toolbox solutions from CS Odessa equip project managers with effective tools to deal 
with unique problems. 

Working with You

In our work and dialog with ConceptDraw users we see a variety of projects of all sizes. 
Sometimes these projects take days, others take years. .
Each project has individual objectives, operates in different subject domains,.
and can have different complexities .
and tasks. 

The numerous unique project situations 
are important for each participant .
and require the correct tools to help .
with decision making. In all of these cases 
we strive to create solutions .
to improve efficiency when you .
are managing projects. 

The variety of projects that you undertake 
drives us to build tools that help manage 
projects of any size scope and to solve 
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project situations at any time. That is why we give great attention to our project 
management solutions. We look for innovation in project management..
We are focused on delivering solutions that help you implement innovation.
in your projects. Our responsibility is to help you achieve project success .
by providing tools that assist in the management of completing tasks,.
increasing the personal effectiveness of each participant,.
and allowing transparent project communication..
We partner with you to achieve success.

Customer-focused solutions for managing projects is core to our experience of building 
tools to manage projects, build mind maps, and draw diagrams. 

Our goal is to build solutions to help you start faster and be more effective in project 
execution, regardless of your experience level. Our focus is to help you be successful,.
no matter what the project methodology used, the size of the project, .
or the experience of the team. 
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PM Easy

Benefits  
This solution helps you quickly start .
a project by listing task relationships .
and dependencies to make iterative 
planning easy. Visual tools, such as mind 
mapping, increase the effectiveness .
of task tracking and analyses.   

Objective 
Support neutral 
methodology project 
management. 

Solution Purpose  
Rapid project startup .
is possible using mind 
mapping to gather 
requirements from your 
team and then plan 
activities in visual .
mind mapping format. 
Using mind mapping .
you can establish time 
lines, delineate tasks, .

assign resources, .
and organize overall project 
structure. The flexibility.
of mind mapping .
for starting a project .
is the most efficient way .
to build the initial .
project plan. 

Intended For  
This solution is targeted .
at project managers .
in small or medium sized 
companies who are looking .
for easy ways to efficiently 
start their projects. 

Products and Methods   
PM Made Easy allows you.
to plan and execute 
projects using mind 
mapping techniques, 
implement planning using 
mind mapping, .
and track tasks using 
ConceptDraw PROJECT.
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Solution Reference: PM Easy

Step 1. Quickly start small projects with mind maps 
By using ConceptDraw MINDMAP you can quickly create a list of project milestones .
and phase definitions using brainstorming to identify these items. When you finish 
brainstorming, your project milestones and project phases are visually organized. 

Tasks and subtasks related to each phase can be identified and placed on the mind map. 
After placement, you can add additional details to the task, such as its relationship .
to an associated task, using the visual tools in ConceptDraw products to identify .
the connection method. After this initial phase is completed for your project, .
with a simple push of a button, your project is exported into a Gantt chart diagram inside 
of ConceptDraw PROJECT.  From that point on, it is easy for the project manager.
to assign all available resources and set up the appropriate project calendars.

Tasks Actions Products

Plan high-level project .
tasks and milestones .
using a mind map 

In ConceptDraw MINDMAP,
use the Input tab and click.
the Quick Project Start button

MM

Use to create details .
for high level tasks 

In ConceptDraw MINDMAP, 
add Subtopics to topics that represent.
project phases 

MM

Use to create logical 
relationships between tasks

In ConceptDraw MINDMAP,
use the Home tab and press .
the Relationship button 

MM

Use to create a project .
from the map

In ConceptDraw MINDMAP,
use  the Output tab and press .
the Create Project Button

MM, PRJ

Use to set properties 
for tasks, phases, 
and milestones 

In ConceptDraw PROJECT, 
use Gantt Chart View (Ctrl+Alt+G) .
and use Task dialog

PRJ
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Tasks Actions Products

Use to add human .
and material resources

In ConceptDraw PROJECT,
use Resource Sheet (Ctrl+Alt+R) .
and  press Enter 

PRJ

Use to setup individual 
calendars for resources

In ConceptDraw PROJECT,
use the Home tab and  Calendar button

Use to assign resources
to tasks

In ConceptDraw PROJECT, 
use Gantt Chart View (Ctrl+Alt+G) .
and use the Assign Resources table

PRJ

Use to send today’s to-do list 
to project participants

In ConceptDraw PROJECT, use Gantt Chart 
View (Ctrl+Alt+G) to select a Phase .
Next, right click to use the context menu, .
and then select Microreport ->Today task list 
with assigned resources

PRJ

Step 2. Track and control the project directly in the project views
Track tasks, phases, and milestones; change dependencies and completions; .
track assignments and availability of resources.

Tasks Actions Products

Use to track the executions of 
tasks, phases, 
and milestones

In ConceptDraw PROJECT,
Use Gantt Chart View (Ctrl+Alt+G)

PRJ

Use to change work 
assignments

In ConceptDraw PROJECT, 
use Gantt Chart View (Ctrl+Alt+G) 
and use the Assign Resources table

PRJ
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Step 3. Dynamically plan and detail project phases using mind mapping
Define phases of a project using mind mapping. Set dependencies between tasks .
and assign resources. 

Tasks Actions Products

Use to determine details .
for the next project phase 
using a mind map

In ConceptDraw PROJECT, 
use the Application Button and use .
Send -> Open in MINDMAP.
Add more topics and subtopics related .
to the project

PRJ, ММ

Use to create dependencies 
between tasks and to setup 
logical connections

In ConceptDraw MINDMAP, 
use the Home tab.
and click the Relationship button.
You can setup dependencies .
as start-to-start, start-to-finish, finish-to-start, .
or finish-to-finish

ММ

Use to assign resources 
to tasks

In ConceptDraw MINDMAP, 
use the Output “Open in Project”,
in ConceptDraw PROJECT assign resources 
to tasks 

 ММ, PRJ

Step 4. Visualize different phases of the project using diagrams
Visual diagrams give you the ability to view at a detailed level project attributes such .
as project scope, logical connections in the project, critical paths, key events 
on the timeline, milestones, tasks, calendars for work, and resource utilization.

Tasks Actions Products

Use for Work Breakdown 
Structure diagram 
and to show detailed .
project scope

In ConceptDraw PROJECT,
use  the Reports tab and click 
“WBS Diagram” 

PRJ, PRO

Use PERT Chart to show 
logical dependencies of tasks 
and critical project paths 

In ConceptDraw PROJECT,
use the Reports tab and click “PERT Chart”

PRJ, PRO
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Tasks Actions Products

Use Timeline to show 
the time sequence of project 
milestones and upper-level 
phases

In ConceptDraw PROJECT,
use the Reports tab and click “Timeline”

PRJ, PRO

Use Resource Calendar 
to show general .
and personal work calendars

In ConceptDraw PROJECT,
use the Reports tab and click 
“Resource Calendar”

PRJ, PRO

Use Milestone Chart to 
show sequences and logical 
dependencies of milestones

In ConceptDraw PROJECT,
use the  Reports tab and click 
“Milestone Chart”

PRJ, PRO

Use Resource Usage Diagram 
to show project resource 
usage

In ConceptDraw PROJECT,
use the Reports tab and click 
“Resource Usage Diagram”

PRJ, PRO

Use Radial Tasks Diagram
to show the most labor-
consuming tasks .
and project phases

In ConceptDraw PROJECT,
use  the Reports tab and click 
“Radial Tasks Diagram”

PRJ, PRO

Use for Work Breakdown 
Structure diagram and to 
show detailed project scope

In ConceptDraw MINDMAP 
use the Output “WBS Diagram”

MM, PRO

Use PERT Chart to show 
logical dependencies of tasks 
and critical project paths

In ConceptDraw MINDMAP
use the Output “PERT Chart”

MM, PRO

Use Gantt Chart to show 
logical dependencies of tasks 
and critical project paths

In ConceptDraw MINDMAP 
use the Output “Gantt Chart”

MM, PRO
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PM Agile

Benefits 
All Agile meetings and documents .
are powered by mission adapted .
mind map templates, specially tuned .
for collaborative work. .
Tracking project Velocity is easy .
when using ConceptDraw Velocity .
diagram templates.

Objective  
Support Agile methods such 
as user stories, iteration 
planning, burndown charts, .
backlogs, and velocity. 

Solution Purpose  
These visual tools assist 
in the holding of Scrum-
meetings, collaborative 
planning for Sprint, 

maintaining backlog,  .
and calculating .
and reporting the Velocity .
of the team.

Intended For 
Companies using Agile 
methodology; specifically, 
Scrum; Product Owners, 
Scrum Masters.

Products and Methods   
In the background 
of this solution we use .
mind mapping .
for visualization of key 
events and artifacts .
of Agile methodology. Key 
diagrams for visualization .
are made by .
ConceptDraw PRO.
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Solution Reference: PM Agile

Step 1. Visualize Scrum meeting agendas and artifacts as mind maps
Use mind map templates for creating maps for Scrum meetings (Sprint Planning, .
Daily Scrum, Sprint Review (Demo), Sprint Retrospective) and artifact (Sprint Backlog, 
Scrum-ban Task Board), taking notes during meetings using agenda as an outline .
and fill Sprint backlog during the meeting. You receive nice looking, readable, 
professional mind maps that document your status. 

Tasks Actions Products

Use Sprint Planning 
to visualize the Sprint 
Planning meeting agenda

In ConceptDraw MINDMAP,
use the input “Sprint Planning” 
(Sprint Planning.cdmtz)

ММ

Use Sprint Backlog .
to visualize the Sprint 
Backlog

In ConceptDraw MINDMAP,
use the template “Sprint Backlog” 
(Sprint Backlog.cdmtz)

ММ

Use Daily Scrum 
to visualize the Daily .
Scrum meeting agenda .
as a mind map

In ConceptDraw MINDMAP,
use the input “Daily Scrum” 
(Daily Scrum.cdmtz)

ММ

Use Sprint Review 
to visualize the Sprint Review 
(Demo) meeting agenda.
as a mind map

In ConceptDraw MINDMAP,
use the input “Sprint Review (Demo)” 
(Sprint Review (Demo).cdmtz)

ММ

Use Sprint Retrospective 
to visualize the Sprint 
Retrospective meeting 
agenda as a mind map

In ConceptDraw MINDMAP,
use the input “Sprint Retrospective” 
(Sprint Retrospective.cdmtz)

ММ

Use Task Board to visualize 
the Scrum-ban Task Board.
as a mind map

In ConceptDraw MINDMAP,
use the input “Task Board” 
(Task Board.cdmtz)

ММ
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Step 2. Quickly create Burn Down and Velocity Charts
Enter data using our templates to make professional Scrum diagrams, 
Release Burn Down Charts, Sprint Burn Down Charts, and Velocity Charts. 

Tasks Actions Products

Use the Release Burn Down 
Chart to visualize a project’s 
progress by Sprint, 
as the remaining work on the.
Release Burn Down Chart

In ConceptDraw PRO,
use the template “Release Burn Down” 
(Release Burn Down.cdt)

PRO

Use the Sprint Burn Down 
Chart to visualize the Sprint 
progress by days, 
as the remaining work 
on the Sprint Burn .
Down Chart

In ConceptDraw PRO,
use the template “Sprint Burn Down” 
(Sprint Burn Down.cdt)

PRO

Use the Velocity Chart
to visualize the sum 
of estimates of the work 
delivered across all Sprints 
on the Velocity Chart 

In ConceptDraw PRO,
use the template “Velocity Chart” 
(VelocityChart.cdt)

PRO
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PM Response

Benefits
This solution helps improve response time 
to project changes. PM Response also 
helps with iteration planning, .
discussing project layout approaches,.
and solving project challenges.

Objective 
Plan how to respond 
to issues and events that 
impact the project. 

Solution Purpose 
Use project maps to plan, 
convert project mind maps 
to project implementations, 
represent the project .
as a project map, use visual 
diagrams to solve problems 
and make .

decisions, and plan .
resource usage 
to respond to changes 
in the project environment. 

Intended For
Managers, team leaders, 
and participants.

Products and Methods 
In the background 
of the solution, you use 
mind mapping for iteration 
planning and applying .
project changes, .
representing project data 
as a project mind map .
for clearer understanding, 
discussing detail 
breakdown, creative 
collaboration, .
and decision-making.



Solution Park Support for Project Management

23

Solution Reference: PM Response

Toolbox 1. Create part of or an entire project in a mind map
Using a mind map structure makes it easy to assess, discuss, and troubleshoot 
a project quickly. The mind map displays a list of milestones, phases, tasks, and other 
important project data in a visual format that is easy to work with. Project teams .
are able to quickly assess project conditions and adapt the strategy to respond .
to current situations. Project data can be modified in a mind map view and then folded 
back into the project plan, making project iterations easy, timely, and accurate.  

Tasks Actions Products

Use to brainstorm 
and formulate list .
of milestones, phases, .
and tasks with the team

In ConceptDraw MINDMAP, 
use the Input tab .
and click the Brainstorm button

MM

Use to set the data .
for milestones, phases, .
and tasks

In ConceptDraw MINDMAP, 
use dialog for Topic Type (F10) and choose
the appropriate topic type.
Put the data in the selected topic data table

MM

Use to convert the map 
to part of the project

In ConceptDraw MINDMAP, 
select all map topics (Ctrl+A) .
and copy topics (Ctrl+C) 
In ConceptDraw PROJECT, 
position the curser where you want to place 
material and paste (Ctrl+V)

MM, PRJ

Use to open the mind map 
as the same file .
in the project 

In ConceptDraw MINDMAP, 
use  the Output tab .
and click the Open in PROJECT Button

MM, PRJ

Use to open the mind map 
in a new project file

In ConceptDraw MINDMAP, .
use the Output tab .
and click the Create Project button

MM, PRJ
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Toolbox 2. Create a mind map to describe part of the project
This is a convenient way to isolate a part of your project and resolve any issues .
related to that part.  It is also great for meetings and collaborating with teams .
on problem solving. 

Tasks Actions Products

Use to create a map 
for the project

In ConceptDraw PROJECT, 
use  the Reports tab .
and click the Create Mindmap button

MM, PRJ

Use to represent the project 
as a map

In ConceptDraw PROJECT, 
use Application Button Send ->Open 
in MINDMAP

MM, PRJ

Use to represent part 
of the project as a map

In ConceptDraw PROJECT, 
select tasks and copy (Ctrl+C)
In ConceptDraw MINDMAP, 
paste tasks (Ctrl+V)

MM, PRJ

Toolbox 3. Analyze pros and cons of the current situation and make decisions
Create fishbone diagrams and other meaningful visual project diagrams to better 
understand and analyze problems. This process helps project managers make better 
decisions related to their projects. 

Tasks Actions Products

Use to create fishbone 
diagrams for decision-
making

In ConceptDraw MINDMAP, 
use the Output tab .
and click the Fishbone button

MM, PRO
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Toolbox 4. Visually plan resource allocation and usage 
Resource diagrams help plan resources and visually identify the most resource-heavy 
tasks and phases.

Tasks Actions Products

Use Radial Tasks diagrams 
to identify resource-heavy 
tasks and phases

In ConceptDraw PROJECT, 
use the Reports tab .
and click the Radial Tasks Structure button

PRJ, PRO
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PM Teams

Benefits 
ConceptDraw Solution Park creates 
a single information space for messaging 
to teams. PM Teams provides project 
participants and organizations with better 
tools that assist in task understanding, 
timeframe understanding, and project 
events in the entire organization. 
Improved communication fosters positive 
team spirit throughout. 

Objective 
Prepare organization charts, 
roles and responsibility 
matrices, team directories, .
and calendars. 

Solution Purpose 
Quickly create organizational 
charts, work calendars, 
and resource calendars 
using the graphic capability 
in ConceptDraw Office. 
Easily exchange project 
information and project 
maps with people .
who do not have 

ConceptDraw Office, .
using the powerful .
output capabilities 
in ConceptDraw Office.

Intended For  
Project managers who 
need to communicate with 
managers throughout 
the organization including 
human resources 
managers, senior 
managers, stakeholders, 
and department .
managers.

Products and Methods  
The solution’s focus 
is on calendars .
and work charts. This tool 
sends messages to team 
members to let them know 
what is happening 
in a project. Use these tools 
to exchange information.
for internal audiences 
(team and task) 
and external audiences 
(organization, 
administration and other 
projects). 
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Solution Reference: PM Teams

Toolbox 1.Create organization charts for project departments and organizations
Use mind mapping to enter organizational chart information. Use ConceptDraw PRO.
“Organizational Charts” library to create small or large organizational charts.

Tasks Actions Products

Use Organizational Chart 
to create department 
or company-wide 
organizational Charts

In ConceptDraw MINDMAP, 
use the Input tab, click the New Mind Map 
button, and enter data.
Use the Output tab.
and click the Org chart button

MM, PRO

Use to create project team 
organizational charts

In ConceptDraw PRO,
use the Organization Charts templates

PRO

Toolbox 2. Create a calendar of “Who Does What and When?” 
Quickly create a Resource Usage Calendar or any professional diagrams for working with 
project resources.

Tasks Actions Products

Use “Who does what 
and when”

In ConceptDraw PROJECT,
use the  Reports tab 
and click the Resource Calendar button

PRJ, PRO

Use Resource Usage 
Calendar

In ConceptDraw PROJECT,
use  the  Reports tab 
and click the Resource Usage Button

PRJ, PRO
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Toolbox 3. Exchange diagrams with your colleagues  
to communicate project status
Effectively exchange maps, project reports, and diagrams with teammates who do not 
have ConceptDraw Office.

Tasks Actions Products

Use to exchange project data 
with people who do not have 
ConceptDraw PROJECT

In ConceptDraw PROJECT, 
use the Application button 
and use the Import and Export menus 
to select the desired format

PRJ 

Use to exchange project data 
with people who do not have 
ConceptDraw MINDMAP

In ConceptDraw MINDMAP, 
use the Application button 
and use the Import and Export menus 
to select the desired format

MM

Use to exchange project data 
with people who do not have 
ConceptDraw PRO

In ConceptDraw PRO, 
use the Application button 
and use the Import and Export menus 
to select the desired format

PRO
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PM Docs

Benefits 
Organize project and company 
documentation and structure information 
that relates to project. PM Docs makes .
it easier to locate pertinent 
documentation over the life .
of the project; by improving document 
access and minimizing search time. .
The end result is improved productivity.
of the project team. 

Objective 
Organize and create project 
documentation.

Solution Purpose 
Organize project 
documentation, link project 
documentation to tasks, 
phases, and resources. Link 
or embed documentations 
into project topics. .
Create professional 
Microsoft Word documents 
using project maps.  

Intended For  
Project managers and key 
project participants who 
write specifications 
and create documentation. 

Products and Methods 
The solution background 
uses mind mapping 
as a tool to create 
structures and organize 
project documents. .
Create structure .
in a mind map, link .
the correct documents .

to keep documents 
organized in a project, 
and if you need a formal 
approach you can quickly 
convert mind map to a MS 
Word document. .
With a mind map you can 
embed, hyperlink, and sort 
documents, and you can 
also visually differentiate 
document types.
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Solution Reference: PM Docs

Toolbox 1. Create a text outline document from a mind map
Any mind map can be converted into a professional Microsoft Word document. 

Tasks Actions Products

Use to convert a mind map 
to MS Word doc

In ConceptDraw MINDMAP, 
select the Output tab, .
and click the Word Outline button

MM, 
MS Word

Toolbox 2. Organize and structure project documentation
Link project documents to tasks, phases, and resources. You can embed specifications.
or requirement documents in project or task topics.

Tasks Actions Products

Use to hyperlink project 
documents to projects, tasks, 
phases, and milestones 

In ConceptDraw PROJECT, 
select a task and click hyperlink the icon

PRJ

Use to embed specification 
documents in projects, tasks, 
phases, and milestones

In ConceptDraw MINDMAP, 
select Topic, open the Topic Types dialog (F10) 
and, select the topic type 
“Specification Document”  
Double-click on “Specification Document” 
name and then use the Attach 
button to embed a document in topic

MM

Use to embed requirements 
documents in projects, tasks, 
phases, and milestones

In ConceptDraw MINDMAP, 
select Topic, open the Topic Types dialog 
(F10),  and select  the topic type 
“Requirements Document”  
Double-click on “Requirements Document” 
name and then use the Attach 
button to embed a document in topic

MM
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PM Presentations

Benefits 
The presentation becomes a key 
component of your company’s 
organizational process when you can use 
available project information .
in your meetings that is tuned to audience 
requirements. By using the same data .
and building targeted presentations .
for your audience you compound .
your efficiency and clearly communicate .
the appropriate information to different audiences from a single source..
The power behind this solution improves your efficiencies in many stages.
of the project management process.

Objective 
Deliver presentations 
that use all project data, 
including dashboards, Gantt 
charts, resource views, 
reports, and diagrams.

Solution Purpose 
Create and show 
presentations using maps, 
project diagrams, timelines, 
calendars, and other views 
of project steps. Teams can 
collaboratively edit 
in Full-Screen  Mode 
to rapidly revise or plan 
a project.

Intended For  
Project Managers.

Product and Methods   
Use ConceptDraw MINDMAP 
to collect information, use 
ConceptDraw PROJECT .
to generate slide 
illustrations on project 
status, and use project 
diagrams to describe 
project details and status 
from ConceptDraw Pro. 
Assemble this information 
into one presentation using 
ConceptDraw PRO 
or ConceptDraw MINDMAP. 
You can also use other 
presentation tools or web 
presentation formats.

There are many different .
ways to present your 
information depending .
on the amount of time .
you have to prepare.   .
You can professionally 
present with NO 
preparation time using .
ConceptDraw MINDMAP.
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Solution Reference:  PM Presentations

Toolbox 1. Collaborative editing in Full-Screen Mode 
Collaboratively edit using Full-Screen Mode to view either the full map or a section 
of the map using one-click navigation. 

Tasks Actions Products

Used to edit the map 
without toolbars

In ConceptDraw MINDMAP, 
use Full-Screen Mode (Shift+F5) .
without tool bars 

MM

Use to zoom into any 
section of the map with .
one click 

In ConceptDraw MINDMAP, 
use the One Click Navigation feature set 
To zoom into any section of the map .
select it by holding down the left mouse 
button Release the button to return .
to the previous view or use the Escape key .
or right click to stay zoomed in  

MM

Toolbox 2. Create and demonstrate presentation of a mind map
Create and demonstrate with one click.

Tasks Actions Products

Use to automatically make 
slides based on map content

In ConceptDraw MINDMAP, 
use the View tab and click .
the Create Default Presentation Button

MM

Use to demonstrate 
the presentation using 
ConceptDraw MINDMAP 

In ConceptDraw MINDMAP, 
use the View tab and click 
the Presentation Mode (F5) button

MM
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Toolbox 3. Demonstrate project diagrams as a presentation on a large screen 
You can demonstrate any project diagram or schematic on a full screen.

Tasks Actions Products

Use to demonstrate 
a graphical document .
on a secondary monitor .
or projector

In ConceptDraw PRO, 
click the Presentation Mode (F5) button

PRO

Toolbox 4.  Generate slides from any ConceptDraw application and incorporate 
slides in a master slide presentation
Make Microsoft PowerPoint presentations from your mind maps, project views, technical 
schemes, and diagrams. Use ConceptDraw Office export capabilities to generate slides 
that can be incorporated into your PowerPoint presentations. 

Tasks Actions Products

Use ConceptDraw MINDMAP 
to create slides .
for PowerPoint .
from map data

In ConceptDraw MINDMAP, 
use the Menu File -> Export ->.
MS 
PowerPoint Presentation

MM

Use ConceptDraw PROJECT
to create slides 
for PowerPoint .
from project data

In ConceptDraw PROJECT,
use (Ctrl+Shift+C) to capture slides
Use the Report tab .
and click the PowerPoint button (Ctrl+Alt+S)

PRJ

Use ConceptDraw PRO 
to create slides 
for PowerPoint from project 
graphs, diagrams, .
or schemes

In ConceptDraw PRO
use File -> Export ->.
Microsoft PowerPoint

PRO
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PM Meetings 

Benefits  
PM Meeting makes preparing 
for meetings a quick task. Meetings 
become more efficient because 
of the ability to easily record results. 
Collaborative decisions made 
by the project team are captured .
as part of the meeting process and then 
distributed. This innovative process 
makes meetings more productive .
and keeps activities on track. Meeting notes can be easily distributed at a meeting’s 
conclusion to all participants and stakeholders.

Objective  
Prepare project meetings 
quickly, keep meetings 
on track, organize 
team brainstorming, 
record brainstorming 
results, and share 
meeting results.

Solution Purpose  
Easily prepare for regular 
meetings using .
templates provided 
in ConceptDraw MINDMAP. 
Brainstorm ideas, track 
meeting agendas, 
collaboratively edit, 
and easily share 
meeting results.

Intended For  
Project manager, team 
leaders, and meeting 
organizers.

Products and Methods  
Using mind maps changes 
boring meetings into 
a work space for creative 
and productive work 
for the entire team.
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Solution Reference:  PM Meetings

Toolbox 1. Prepare meetings quickly 
Using the meeting agenda template map accelerates meeting preparation.

Tasks Actions Products

Use mind maps to create 
meeting agendas

In ConceptDraw MINDMAP,
use the template “Meeting Agenda Map” 
(MeeteingAgendaMap.cdmtz)

ММ

Toolbox 2. Collaborative brainstorming 

Using the brainstorming mode in ConceptDraw MINDMAP lets you brainstorm .
and achieve positive meeting results. 

Tasks Actions Products

Use Brainstorm to take 
meeting notes .
for immediate distribution 
at the meeting’s conclusion

In ConceptDraw MINDMAP,
use the Input tab and click Brainstorm

ММ
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Toolbox 3. Collaborative document creation and meeting note process
Work in Full -Screen mode with your team to capture all meeting details. .
Zoom in to any section of the map for better viewing; zoom out instantly to see .
the entire project. 

Tasks Actions Products

Use to display a map 
on the screen without 
toolbars to distract from map 
content

In ConceptDraw MINDMAP, 
click Full-Screen Mode (Shift+F5)

ММ

Use to edit and discuss .
a part of the map

In ConceptDraw MINDMAP, 
use the One Click Navigation feature set. 
To zoom into any section of the map select .
it by holding the left mouse button down 
Release the button to return to a previous 
view or use the Escape key or right .
click to stay zoomed in

ММ

Use to make a Microsoft Word 
text document 
as a result of the meeting

In ConceptDraw MINDMAP, 
use the Output menu and select Word Outline

ММ, MS Word
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PM Planning

Benefits 
PM Planning automatically creates 
documents that reflect a project’s status 
for people who have different project 
roles. Individuals are able to use 
the reporting capability built into 
ConceptDraw Solution Park for their 
benefit. The report capability addresses 
more than management requirements 
and is a great tool to guide individual task 
completions. This solution in ConceptDraw Solution Park improves planning for all team 
members and is a strong management and productivity tool. 

Objective  
Extend your planning 
and reporting capability, 
prepare a wide range .
of project reports,  .
and improve project .
communications.

Solution Purpose 
Create project reports that 
address the needs .
of project managers 
and senior management 
and keep everyone 

informed on daily progress 
and monthly objectives. 
These collective reports 
help accurately plan, 
maintain, and finish .
projects on time.   

Also available are short 
Microreports that can 
you can email to project 
members to keep everyone 
updated on project 
statuses, tasks, .
and resources.

Intended For
Project managers.

Products and Methods  
Report Basket is a tool .
for the effective planning 
of different project stages. 
The Report Basket makes 
the process of reporting 
simple and is a good .
tool for planning, 
communicating, .
making decisions, 
and doing analytical work.
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Solution Reference:  PM Planning

Toolbox 1.  Use the mind map style to present project reports
Use the mind map style reports to document statuses, tasks, and milestones selected by 
time status attributes. 

Tasks Actions Products

Use All Tasks Status Report 
output

All Tasks Status Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP 

MM

Use Completed Tasks Report 
output

Completed Tasks Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM

Use Tasks in Progress Report 
output

Tasks in Progress Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM

Use Unstarted Tasks Report 
output

Unstarted Tasks Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM

Use Critical Tasks Report 
output

Critical Tasks Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM

Use Overdue Tasks Report 
output

Overdue Tasks Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM

Use Started Tasks Report 
output

Started Tasks Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM
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Tasks Actions Products

Use On- Time Tasks Report 
output

On-Time Tasks Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM

Use Today Tasks Report 
output

TodayTasks Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM

Use Tomorrow Tasks Report 
output

Tomorrow Tasks Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM

Use Future Tasks Report 
output

Future Tasks Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM

Use This Week Tasks Report 
output

This Week Tasks Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM

Use Next Week Tasks  Report 
output

Next Week Tasks Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM

Use All Milestones Report 
output

All Milestones Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM

Use completed Milestones 
Report output 

Completed Milestones Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM

Use overdue Milestones 
Report output

Overdue Milestones Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM
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Tasks Actions Products

Use Future Milestones Report 
output

Future Milestones Report is a one click 
operation from the Output menu 
in ConceptDraw MINDMAP

MM

Toolbox 2. Daily communication by e-mail  
Communicate daily with quick emails consisting of data about current project status, 
changes, tasks, phases, and resources.

Tasks Actions Products

Use to send an email 
message about tasks, 
assignments, phases, .
and resources

In ConceptDraw PROJECT,
use Gantt Chart View (Ctrl+Alt+G), select 
a phase or task, right click, and use thes 
Today Tasks List, Critical Tasks List, 
Today Tasks List with Assigned Resources, 
or Today Resources List Microreports

PRJ, .
e-mail client

Use to send email with .
the status of one task .
or a few selected tasks

In ConceptDraw PROJECT,
use Gantt Chart View (Ctrl+Alt+G),.
select the task, right click, .
and use Microreports -> Task Status

PRJ, .
e-mail client

Use to send email on status 
of resources, Today Task List, 
Today Resource List,.
and Nearest Milestones 

In ConceptDraw PROJECT,
use Project Dashboard View (Ctrl+Alt+P), 
select project and right click to use 
the Today Tasks List, Today Resources List,  
or Nearest Milestones Microreports

PRJ, .
e-mail client

Use to send email that relates 
to an individual contribution 
to a project. Choices include 
Today Tasks List, Milestones, 
Objectives, Projects List, Next 
Tasks, and Assigned Tasks  

In ConceptDraw PROJECT,
use Resources View (Ctrl+Alt+R),.
select resource, right click, and use one 
the  Today Tasks List, Milestones, Objectives, 
Projects List, Next Tasks, 
or Assigned Tasks Microreports

PRJ, .
e-mail client
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Toolbox 3. Weekly reporting on a project 
This is a collection of the most important reports for weekly communication about 
current activity and resources for project managers and senior management. 

Tasks Actions Products

Use Current activities,.
weekly reports

In ConceptDraw PROJECT, 
use the Reports menu and select 
Current activities, weekly

PRJ, Excel, 
MM

Use Resource usage weekly In ConceptDraw PROJECT, 
use the Reports menu and select 
Resource usage, weekly

PRJ, Excel, 
MM

Use Executives weekly report In ConceptDraw PROJECT, 
use the Reports menu and select 
Executives, weekly

PRJ, Excel, 
MM

Toolbox 4. Monthly budget report
This is a monthly budget report that reflects actual and planned budget items 
and is used by project managers and senior managers. 

Tasks Actions Products

Use to make a monthly 
project costs budget report

Use the Reports tab, click the Reports button, 
and choose Costs, monthly 

PRJ, Excel, 
MM

Use to make a Resource 
Usage monthly report

Use the Reports tab, click the Reports button, 
and choose Resource Usage, monthly

PRJ, Excel, 
MM

Make an Executives .
monthly report

Use the Reports tab, click the Reports button, 
and choose Executives, monthly

PRJ, Excel, 
MM
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Toolbox 5. Working document in planning process
This is a collection of reports used by project managers at the time of project planning 
and at the completion of the planning process.

Tasks Actions Products

Use Project Start: 
Comprehensive report .
for initial planning

Use the Reports tab click the Reports button, 
and choose Project start

PRJ, Excel, 
MM

Use Planning Reports: .
Daily reports.
for the planning process

Use the Reports tab, click the Reports button, 
and choose Planning Reports

PRJ, Excel, 
MM

Toolbox 6. Detailing, planning next phase of project 
This report collection helps plan and execute project phase.

Tasks Actions Products

Use Phase Report: Generate 
the project phase report 

Use the Reports tab, click the Reports button, 
and choose Phase start

PRJ, Excel, 
MM

Toolbox 7. To sum up project results
Product information which was summarized helps consolidate the results .
and finish a project. 

Tasks Actions Products

Use Project Results Report Use the Reports tab, click the Reports button, 
and choose Project finish

PRJ, Excel, 
MM
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PM Dashboards 

Benefits  
PM Dashboards clearly displays identified 
key performance indicators for any 
project. Dashboards demonstrate .
to project managers where corrective 
action needs to be taken.

Objective  
Create dynamic information 
dashboards based 
on your project data.

Solution Purpose 
By dynamically charting 
a project’s key performance 
indicators (KPI) that are 
collected on one display, all 
project team members have 
access to the daily status 
of the projects .
they are involved in. .
PM Dashboards visually 
demonstrates changes .
to the budget status .
and clearly demonstrates 
progress toward 
a project’s objectives.

Intended For  
All project participants, 
project managers, .
team members, team 
leaders, stakeholders, .
and the entire .
organization.

Products and Methods  
We transform project .
data into visually attractive 
dashboards which update 
dynamically. 
In the PM Dashboards 
Solution we use 
ConceptDraw PROJECT 
to maintain project data, 
and we use 
ConceptDraw PRO .
for producing updated 
dashboards .
that are connected .
to live project data.  

The technology that .
enables the construction 
and updating .
of the dashboards is our 
Live Object technology .
that is contained .
in ConceptDraw PRO. .
The Live Object technology 
allows us to connect .
a complex object shape .
to an external data source 
so that dynamic updates 
happen from changes .
in the data. .
For the dashboard’s .
Live Objects, .
look in the library .
“Business Dashboards”.
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Solution Reference:  PM Dashboards

Toolbox 1. Operational Tracking by using the Daily Dashboard 
Collects key performance indicators for all of the projects in your company.

Tasks Actions Products

Use the Daily Dashboard 
for tracking all projects

In ConceptDraw PROJECT,
use  the Reports menu,  
and select the “Daily Dashboard”

PRJ, PRO

Toolbox 2.  Tactical Project Tracking
Gathers tactical key performance indicators for all of the projects in your company.
(how many people are available, budget available, and time available).

Tasks Actions Products

Use the Tactical Dashboard.
to track how many people.
are available, budget 
available, and time available

In ConceptDraw PROJECT,
use  the Reports menu 
and select “Tactical Dashboard”

PRJ, PRO

Toolbox 3. Strategy Tracking
Gathers information from key performance indicators for all projects in your company.

Tasks Actions Products

Use Strategy Tracking to track 
strategic key performance 
indicators including document 
readiness, task preparedness, 
and know-ledge growth 
during a project life cycle

In ConceptDraw PROJECT,
use the Reports menu, 
and select “Strategy Dashboard”

PRJ, PRO
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Personal Time Management

Benefits  
The PM Personal Time Management 
solution helps every project participant 
track timeframe, workspace and function .
in a project with the help .
of Microreports, calendars, 
and to-do lists.

Every project participant stays informed 
about task lists, calendars and future 
tasks for self and colleagues. .
The PM Personal Time Management .
solution is good for collaborative work, keeping everyone informed on what and when 
tasks need to be done. Time Management is critical for the success of any project. 

Objective  
Improve personal 
performance.

Solution  
Generate personal to-do 
list, personal calendar, 
and project check lists. 
Communicate using email 
with one click.

Intended For  
All project participants.

Products and Methods  
Individuals have access 
to personal calendars, 
to-do lists, personal 
assignment lists, .
and project checklists. 
Participants communicate 
all this with Microreports via 
email. 
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Solution Reference:  Personal Time Management

Toolbox 1. To-do List, stay informed
Keep participants informed of all current and upcoming tasks that involve 
their participation.

Tasks Actions Products

Use to email all current 
Assigned Tasks .
in a mind map

In ConceptDraw PROJECT,
use Resources View (Ctrl+Alt+R),.
select resource, right click, use Microreports, 
and go to “Assigned Tasks”

PRJ, MM, 
e-mail client

Use to email all Next Tasks 
in a mind map

In ConceptDraw PROJECT,
use Resources View (Ctrl+Alt+R),.
select the resource, right click,.
use Microreports , and go to “Next Tasks”

PRJ, MM, 
e-mail client

Toolbox 2. Personal Calendar, stay informed
Send a personal calendar of project tasks to any participant.

Tasks Actions Products

Use to generate personal 
calendars for one month

In ConceptDraw PROJECT,
use  the Reports tab .
and click the Resource Calendar button

PRJ, PRO
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Toolbox 3. Create a checklist for the entire project  or part of a project
Generate check lists for project tasks for the upcoming two weeks.

Tasks Actions Products

Use to create an entire 
project checklist or partial 
project checklist 
for the upcoming two weeks

In ConceptDraw MINDMAP,
use the Output tab and select 
“2 Weeks Task Check List”

MM, Word


